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LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS!

Opening and using the enclosed software for any purpose indicates your acceptance of the terms and
conditions of this license agreement. If you do not agree with them you should return all software and
documentation within seven days of shipment unopened and your money will be refunded.

Fastwel provides this program and licenses its use in the United States or internationally. You assume the
responsibility for the selection of the program to achieve your intended results, and for the installation, use
and results obtained from this program.

LICENSE

You are granted a personal license to use this program under the terms stated in this Agreement. You may:
1) Install and use the program on a single machine. 2) Make archival back-up copies of the program for the
sole purpose of supporting your use of the single program on a single machine. 3) You may not use, copy,
modify, or transfer the program, or transfer any copy, in whole or in part, except as expressly provided in
this license, or with a written contractual agreement with Fastwel, Inc.

TERM

The license is effective until terminated. It will terminate if you fail to comply with any term or condition of
this Agreement. You agree, upon such termination, to destroy the program and all copies which were made
from it.

LIMITED WARRANTY

FASTWEL WARRANTS THE CD-ROM OR PHYSICAL DISKETTES, ON WHICH THE PROGRAM
IS FURNISHED, AND PHYSICAL DOCUMENTATION TO BE FREE OF DEFECTS IN
MATERIALS AND WORKMANSHIP UNDER NORMAL USE FOR A PERIOD OF NINETY (90)
DAYS FROM THE DATE OF DELIVERY TO YOU AS EVIDENCED BY YOUR RECEIPT. THIS
PROGRAM IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF TITLE,
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH
YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF
ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.

FASTWEL SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED,
INCLUDING BUT NOT LIMITED TO, IMPLIED WARRANTIES OF TITLE, NON-
INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN
PARTICULAR, WITH RESPECT TO ANY PARTICULAR APPLICATION, USE OR PURPOSE, IN
NO EVENT SHALL FASTWEL INC. BE LIABLE FOR ANY OTHER COMMERCIAL DAMAGE,
INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHER
DAMAGES. FASTWEL DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE
PROGRAM WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE
PROGRAM WILL BE UNINTERRUPTED OR ERROR FREE.

LIMITATION OF REMEDIES

Fastwel’s entire liability and your exclusive remedy shall be the replacement of any CD-ROM or diskette
not meeting Fastwel’s "Limited Warranty" which is returned to Fastwel with a copy of your receipt within
the warranty period. The remedy for breach of this warranty shall be limited to replacement and shall not
encompass any other damages including but not limited to loss of profit, special, incidental, consequential,
or other similar claims arising out of the use or inability to use such program even if Fastwel has been
advised of the possibility of such damages, or for any claim by any other third party.

GENERAL

This Agreement will be governed by the laws of the State of Colorado. Should you have any questions
concerning this Agreement, you may contact Fastwel in writing at:

Fastwel, Inc.

882 South Reed Crt.
Suite #E
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Lakewood CO 80226
USA

You acknowledge that you have read this agreement, understand it and agree to be bound by its terms and
conditions. You further agree that it is the complete and exclusive statement of the Agreement between you
and FASTWEL which supersedes any proposal or prior Agreement, oral or written, and any other
communications between you and FASTWEL relating to the subject matter of the Agreement.

FASTWEL RETURN POLICY

All sales are final (NO RETURNS) unless one of the following conditions is applicable: Program is
returned in its original packaging material within 7 days after shipment. In such a case, a full refund is
provided, less all incurred shipping and handling costs. Program is returned within 30 days from the original
shipment date. In such a case a 20% restocking fee is applicable.
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1. Getting Started

The Fastwel ADAM OPC Server is an OPC compliant Server able to communicate with ADAM-4000 and
ADAM-5000/485 remote serial I/O devices and serve data to OPC clients. The ADAM OPC Server was
implemented using advanced programming concepts of the most current version of the OPC specification
(Version 1.0a, July 30, 1997) for use in developing next generation industrial software applications.

1.1 ADAM OPC Server  features

The OPC Server is extremely flexible, and can be utilized and used with DCOM for intranet and internet
applications.

1.1.1 Key features of the ADAM OP C Server

� Advanced OPC data Quality and data conversion to client’s request

� Supports multiple multi-drop I/O Devices

� Supports Multiple Groups for easy configuration and manageability

� Supports up to 4080 devices and modules connected to 16 serial ports

� Internally Simulated for configuration and testing

� Automatically Generated OPC tags for supported device types

� Serial ASCII console mode for data exchange with serial I/O devices manually

� Setting up the device parameters from clients online

� Change Device, Group and Tag properties online

� Flexible engineering units and signal ranges

1.1.2 Supported Devices

The following devices are supported in the current version of the program:

ADAM-4011, 4011D, 4012, 4013, 4014D, 4016, 4017, 4018/M (excepting the data logging feature), 4021,
4050, 4052, 4053,4060, 4080, 4080D,

ADAM-5000/485, including: ADAM-5017, 5018, 5024, 5051, 5052, 5056, 5060.

1.2 System Requirements

The following are system requirements for installing the ADAM OPC Server:

� Windows NT 4.0 (with SR3) or Windows 95 with DCOM is required to use the local server.

� Hardware requirements

� Pentium 133

� 32 MB RAM

� 20 MB HDD

� Serial Port for device communication.

� Installed Internet Explorer 3.02 (or greater) for Windows 95

 If you have installed Internet Explorer 4.0 or wish to install, it is required to read installation notes of
IE4.0. Since DCOM is part of IE4.0 and may have an old version of DCOM.
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1.3 ADAM OPC Server Disk Contents

The Fastwel ADAM OPC Server  comes on two 3.5-inch disks. Later versions can be obtained by
downloading them from the Fastwel WEB site. Visit the Fastwel WEB site at www.fastwel.com for up to
date information.

1.4 Installing the ADAM OPC Server

1. Insert the Fastwel ADAM OPC disk#1 in the 3.5-inch disk drive.

2. In Windows NT 4.0 or Windows 95, click Start, and choose Run.

3. In the Run dialog box, type the following:
A:/Setup
(replacing "A" with the actual location of the 3.5-inch disk drive).

4. Enter the Serial Number for installation as provided by Fastwel.

5. Follow the instructions of the setup program. The setup program will ask you for the folder where
most of the files will be located.

6. The setup program will also ask you for the program folder.

 As explained in the installation section of this manual, Windows NT 4.0 or Windows 95 with the DCOM
is required to run the ADAM OPC Server .

 Internet Explorer 4.0 installs DCOM automatically. However, if using Internet Explorer 3.0, DCOM is
not provided and can be downloaded from Microsoft.com

2. Working with OPC Servers

2.1 Common Definitions

An OPC server is comprised of several objects: the server, the group, and the item.  The OPC server object
maintains information about the server and serves as a container for OPC group objects.  The OPC group
object maintains information about itself and provides the mechanism for containing and logically
organizing OPC items. The OPC Groups provide a way for clients to organize data. Within each Group the
client can define one or more OPC Items. The OPC Items represent connections to data sources within the
server. Associated with each item is a Value, Quality and Time Stamp.  The value is in the form of a
VARIANT, and the Quality. An OPC Item is not accessible as an object by an OPC Client. All access to
OPC Items is via an OPC Group object that “contains” the OPC item, or simply where the OPC Item is
defined.

It should be noted that the items are not the real data sources - they are just connections to them.  For
example, the tags in a distributed control system exist regardless of whether an OPC client is currently
accessing them.  The OPC Item should be thought of as simply specifying the address of the data, not as the
actual physical source of the data that the address references, as shown in the figure below.



Fastwel ADAM OPC Server User's Guide

3

Fig. 2-1

2.2 Configuring an OPC Server

Before connecting to an OPC server for the first time you should perform the following:

1. Configure the physical devices according to appropriate User’s Manuals.

2. Create the instances of Device object that have properties corresponded to parameters of the physical
devices.

3. Create the tag groups that referenced to the parameters of physical devices object model.

4. Save the created configuration.

5. This configuration will be loaded automatically when some clients will access a server.

NOTE: Demo version does not allow loading the configuration automatically when client applications try
to access the Fastwel ADAM OPC Server.

2.3 Connecting an OPC Clients to a Local Server

Connection between clients and a local server (which is resided on the same physical machine with the
clients) does not require any settings of DCOM components to be changed on PC where the clients and
the server are resided. All configuration data required for accessing a server is saved and stored in Registry
on this machine.

2.4 Connecting an OPC Clients to Remote OPC Server

To access a remote OPC server over network, it is recommended to have at least one station that contains
Windows NT 4.0 (Workstation or Server) installed. The NT station is used as the authorization and
authentication server.

Before accessing a remote OPC server, you should configure DCOM parameters on the both stations,
where the client and server are resided.

To start DCOM configuration utility, type “DCOMCNFG” in the Run dialog box, as shown in the figure
below.
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Fig. 2-2

The main interface is displayed on the screen. This interface is divided into three tabs.

1. Applications

2. Default Properties.

3. Default Security.

DCOM Default Properties should be configured for client and server stations as shown in the table below.

Default properties:

DCOM Properties Windows 95/98 Windows NT

Enable distributed COM on this
computer

Checked Checked

Default authentication level None None

Default impersonation level Identify Anonymous

Fig. 2-3 Default DCOM Properties for Windows 95/98
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Fig. 2-4 Default DCOM Properties for Windows NT

Default Security Settings

In Windows 95/98 environment, you should check the Enable Remote Connection checkbox and click on
Edit Default… in the Default Access Permissions group box. In the Access Permissions dialog box, add the
remote stations names where the servers or clients are resided, as shown in the figure below.

Fig. 2-5 Access Permissions Dialog Box

In Windows NT environment, the Security tab looks like shown in the figure below:
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Fig. 2-6 Default Security Tab in DCOM configuration for Windows NT

Click on Edit Default to add or remove the users from the list. You can grant or deny users access
permissions on the machine. This list of users is obtained from the domain where the user is logged in.

Fig. 2-7 Registry Value Permissions Dialog Box

Click on Add to display the current available users list and to add the users.
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Fig. 2-8 Adding the users

Choose Allow Access in the Type of Access combo box. After clicking OK, the Registry Value Permissions
dialog box will contain the item Everyone Allow Access as shown in the figure below.

Fig. 2-9 Assigned type of access to added users

Then you may close the Registry Value Permissions dialog box by clicking OK.

The similar actions must be made for Default Launch Permissions and Default Configuration Permissions
group boxes as shown in the table below.
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DCOM Property Users Level

Default launch permissions Everyone Allow Launch

Default configuration
permissions

Everyone Read

Configuring the particular OPC server is performed in the Applications tab shown in the figure below.

Fig. 2-10 The applications properties tab

For the Fastwel ADAM OPC Server, choose the “adamopc” item in the applications list and click on
Properties. The application properties tabs will be displayed on the screen as shown in the figure below.
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Fig. 2-11 The particular application properties tabs

Click on Location tab and configure the location properties as shown in the table below.

DCOM Property Client Side Server Side

Run application on this
computer

Not checked Not checked

Run application on the
following computer

Checked. The station name where an OPC
server will be launched is put into the edit box

Not checked

In Windows NT environment, you must choose the Identity tab and check the Interactive User check box.

You can toughen the security parameters later but initially it would be better to make efficient the
configuration with the settings described above.

2.5 Data Passing between Clients and Servers

Once the connection between client and server has been established, a client will be able to get data from
and write data to a server. There are two modes of data passing: synchronous and asynchronous.

In the synchronous mode, a client asks a server for the information from items and gets rows of data in the
following format:

Signal Name Value Time MSecs Date Quality

Device1.Group1.Tag1 0.04 21:52:23 587 12/13/98 Good

Device1.Group1.Tag1 0.08 21:52:27 587 12/13/98 Good

Device1.Group1.Tag1 0.13 21:52:31 587 12/13/98 Good

Device1.Group1.Tag1 0.17 21:52:35 587 12/13/98 Good

The rate at that data to be collected from the server is set by client but in most cases clients read items at
maximum speed that they are able to achieve.



Fastwel ADAM OPC Server User's Guide

10

In the asynchronous mode, a client subscribes on the groups of items that must be known by this client. A
server advises a client about changing of values or quality for the items to that a client was subscribed. If the
item value is being changed more than a deadband that was set while establishing a connection, a server
will pass this value to a client (using IAdviseSink::OnDataChange or
IOPCDataCallback::OnDataChange).

A client writes data to a server in the synchronous mode only.

2.6 Terminating an OPC Server

Termination the clients connected to the server will cause the server termination. If the user is being tried
to close a server connected to at least one client, the following message is displayed on the screen.

Fig. 2-12 Notification that clients connected to the server are still exist

You should always normally close connected clients before trying to terminate the server.
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3. User Interface

3.1 Overview

The Fastwel ADAM OPC Server program is a single document Windows application. The main window of
the program shown in the figure below.

Fig. 3-1 The main window of the Fastwel ADAM OPC Server

The application window is splitted into the two panes. The left pane contains a list of devices and tags
groups served by the server. This list is represented in the form of hierarchical tree.

The right pane contains a list of tags created in the selected group or device on the left pane. The following
information is displayed in the tags list:

Name The tag name which was set when this tag has been created. To change the tag name,
right-click on the name and choose Properties menu item. The Tag Properties dialog
box will be displayed on the screen. Type a new tag name in the Name field of the
dialog box.

Type The type of value for the tag. The type is set automatically when creating a tag, and
can be changed like described above.

Location The physical location of I/O channel in the device that is accessed via this tag. For
instance, “Slot1_AI_00” means that the tag is referenced to AI0 channel of certain
I/O module which inserted into Slot1 of the ADAM-5000/485 CPU base.

Processing This column shows whether the scaling is applied to values of the tag.

Value This column contains the real-time values of the tag. To display the tag values,
choose Monitor on the View menu.

Description This column contains brief information about tags. The information can be entered
in the Tag Properties dialog box.
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3.2 Menu Items

3.2.1 File Menu

The File menu includes commands that enable you to open, close, and save new or existing Fastwel
ADAM OPC Server Configuration. Commands include:

New

Use this command to create a new configuration. During or after you create a configuration, you can save
the configuration by using the Save As command.

Open

Use this command to open an existing configuration. Normally, existing configuration is loaded
automatically when some OPC client try to access the Fastwel ADAM OPC Server.

Save

Use this command to save your previously named configuration. To save an unnamed configuration, use
the Save As command.

Save As

Use this command to save a previously unnamed configuration. You can provide a path to where you
would like the configuration to be stored.

Exit

Use this command to exit the Fastwel ADAM OPC Server. You should always normally close the clients
connected to an OPC server before trying to terminate the server.

3.2.2 Add Menu

The Add menu includes commands that enable you to add a Device, Group, and Tag into the current
Fastwel ADAM OPC Server configuration. Commands include:

New Device

Use this command to add a "device" into the current Fastwel ADAM OPC Server configuration. A device
is a collection of parameters that represents a type of physical device whose I/O data will be accessed
through the Fastwel ADAM OPC Server. Once this command is chosen, the Device Properties dialog box
is displayed on the screen. From this dialog box, you can assign a name for the device that will be used for
data passing to/from an OPC clients connected to the Fastwel ADAM OPC Server.

The Device Type radio button is intended for choosing the series of devices that the created device belongs
to.

The Port group box enables you to select a serial port and serial parameters for the COM port that are used
for connection to certain physical device.

The Address group box is intended for searching and locating the physical device referenced by created
device. The Scan button allows you to start scanning a network based on EIA RS-485. The Stop button
enables you to stop scanning. Once a physical device has been found, its Id is displayed in the text field that
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resides on the right from the Address text box. Then you can continue scanning a network by clicking on
Next.

The Console button allows you to directly working with devices connected to selected serial port.

The I/O Modules (I/O Module Type) group box is intended for building a device object that will be used
for creating an OPC tags referenced to the I/O channels of physical device. The I/O module type can be
selected manually in the appropriate combo box. The Autodetect button allows you to determine a device
type automatically, and to build an instance of  device object model for selected device. Even if the physical
device is not connected to the serial port, you should always click on this button for building an instance of
device object model for selected device. The Browse button is used for browsing a device object model
parameters, and for configuring the physical device referenced by that model.

The Simulate check box enables you to create an OPC tags within this device whose values will not be get
from the physical device. These tag values will be simulated using Sine, Ramp and Random laws.

The Device Properties dialog box is shown in the figure below.

Fig. 3-2 Device Properties dialog box

New Group

Use this command to add a "group" into the current Fastwel ADAM OPC Server configuration. A group is
used to organize an OPC items within an OPC server. The Group Properties dialog box is shown in the
figure below.

Fig. 3-3 Group Properties dialog box

New Tag

Use this command to add a "tag" into the current Fastwel ADAM OPC Server configuration. An OPC tag
is a reference to I/O channel or some other parameter of device object model for the selected device. An
OPC clients access the physical device through an OPC server and group objects using the references to the
OPC tags which are called “an OPC items”.
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Once this command is chosen, the Tag Properties dialog box is displayed on the screen. From this dialog
box, you can supply a name, description, data type, and simulated waveform for the created tag. Use the
Browse button in the dialog box to make a link between the tag being created and certain device object
model parameter.

The Tag Properties dialog box is shown in the figure below.

Fig. 3-4 Tag Properties dialog box

NOTE: The Scaling option is unavailable for simulated values in current release of the program.

Generate Tags

Use this command to create an OPC tags automatically. This action can be done in respect to a device that
was previously created and configured.

3.2.3 Edit Menu

The Edit menu includes commands that enable you to edit objects in your Fastwel ADAM OPC Server
configuration and set up the serial ports used for communication with physical devices. To use Edit
commands, you must first select the objects you wish to copy, delete or edit. Commands include:

Cut

To cut objects, select objects that you wish to cut. Then point your mouse to the Cut command and press
the left mouse button. This will cut the selected items. The objects may now be "Pasted" to another
location. Press Paste in the Edit menu. The selected objects are now copied to selected location.
Remember that tag names must always be unique.

Copy

To Copy objects, select objects that you wish to copy. Then point your mouse to the Copy command and
press the left mouse button. This will copy the selected objects into a buffer. The objects may now be
"Pasted" to another location. Press Paste in the Edit menu. The selected objects are now copied to another
location. Remember that tag names must always be unique.

Paste

Once objects are selected, they may be moved/copied to another location by first pressing Cut/Copy, and
then pressing the Paste command. The objects will now be pasted to the selected location.
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Delete

To delete objects, select objects that you wish to delete. Then point your mouse to the Delete command
and press the left mouse button. The objects will be deleted.

NOTE: There is no way to undo this operation.

Port Settings

Use this command to configure the communication parameters that Fastwel ADAM OPC Server will use.
Once this command is chosen, the Port Settings dialog box is displayed on the screen. Standard
conventions are used for the port, parity, and stop bits.

Timeout Read, ms is the time (in milliseconds) that Fastwel ADAM OPC Server will wait for a response
symbols from the serial port device driver.

Timeout Response, ms is the time (in milliseconds) that the serial port device driver will wait for a response
from the device.

The Port Settings dialog box is shown in the figure below.

Fig. 3-5 Port Settings dialog box

Properties

Use this command to modifying the properties of an object currently selected. Once this command is
chosen, the dialog box corresponded to selected object will be displayed on the screen.

3.2.4 View Menu

The View menu includes commands that enable you to display the real-time values for the tags in the right
pane of  main window. The View menu also enables the status bar  to be displayed in the main window.
Commands include:

Monitor

To display or hide the real-time values for the tags in the right pane of main window, highlight this
command with your mouse.

Status Bar

To display or hide a Status bar at the bottom of the Fastwel ADAM OPC Server main window, highlight
this command with your mouse.

3.2.5 Help Menu

The Help menu includes commands that enable you to display a brief information about the program and
to show  Help topics.
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3.3 Creating, Saving and Loading a Configuration

To start a new configuration, use the New command in the File menu.

To open an existing configuration file, click on Open in the File menu. This will invoke a dialog box that
will allow  you to either type in the path and filename of the "*.ACF" file you wish to open into the edit box
provided, or to click through the directory path until the desired filename appears in the filename box.
Highlight your choice. Once you're satisfied with your entry, press OK, double-click on the entry, or press
[Enter]. When at least one client application tries to connect to the Fastwel ADAM OPC Server, an OPC
object "Fastwel ADAM OPC Server" will be created and the most recent modified configuration file will be
automatically loaded.

To save an unnamed configuration file, use the Save As command in the File menu.

3.4 Creating, Configuring and Deleting a Device

3.4.1 Creating a Device

To Create a Device, choose New Device from the Add menu, or left click on the above button. A Device
may have any name, but avoid names with spaces or punctuation such as “|!.,”. Select the COM port
connected to the device, its address and other parameters.

The Device Properties dialog box is shown in Figure 3-2.

There are two options for Device Type: ADAM-5000, and ADAM-4000 series. Choose the proper type
according to your configuration.

The Port group box enables you to select a serial port and serial parameters for the COM port that is used
for connection an appropriate physical device.

The Address group box is intended for searching and locating the physical device referenced by created
device. The Scan button allows you to start scanning a network based on EIA RS-485. The Stop button
enables you to stop scanning. Once a physical device has been found, its Id is displayed in the text field that
is located on the right from the Address text box. Then you can continue scanning a network by using the
Next button.

The Console button allows you to directly working with the devices connected to chosen serial port.

The I/O Modules (I/O Module Type) group box is intended for building a device object that will be used
for creating an OPC tags referenced to the I/O channels of physical device. An I/O module type can be
selected manually in the appropriate combo box. The Autodetect button allows you to determine a device
type automatically, and to build an instance of device object model for selected device. Even if the physical
device is not connected to the serial port, you should always click this button for building an instance of
device object model for selected device. The Browse button is used for browsing a model parameters, and
for configuring the physical device referenced by that model.

The checkbox Simulate switches from reading I/O points from the device to running a simulator. Since the
simulator does not even open the COM port, it is an easy way to work with the server, configuring tags or
connecting clients without requiring any hardware.

Multiple devices can be created, using the same COM port or different ones.

NOTE: Even if the physical device is not connected to the chosen serial port, you should always click on
Autodetect button to creating an instance of the device object model for the selected device type.

3.4.2 Setting a Serial Port Paramete rs

Standard conventions are used for the port, parity, and stop bits.

Timeout Read, ms is the time (in milliseconds) that Fastwel ADAM OPC Server will wait for a response
symbols from the serial port device driver.

Timeout Response, ms is the time (in milliseconds) that serial port device driver will wait for a response
from the device.
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The Port Settings dialog box is shown in Figure 3-5.

3.4.3 Serial Console Mode

The Fastwel ADAM OPC Server allows you to communicate with the ADAM-4000 and ADAM-5000/485
devices in a console mode. In this mode, you can enter a character strings that will be passed to the devices.
Then you will be able to examine a device response strings. The list of character strings used for
communicating with the ADAM series devices is described in the ADAM-4000/5000 User's Manuals.

To start a serial console, click on Console button in the Device Properties dialog box. You will see the
Console dialog box shown in figure below.

Fig. 3-6 Serial Console Dialog box

The Prefix field allows you to choose a command prefix to be sent as the first character in the passed string.

The Address field enables you to specify a device address.

The Slot field enables you to select a slot number in the ADAM-5000 CPU base where the requested I/O
module resides.

The Channel field allows you to specify an I/O channel number in the multi-channel I/O module.

The Command field is intended for specifying a control sequence of characters to be passed. Note that the
Prefix, Address, Slot, and Channel fields can be omitted. In this case, you should specify a character
command including prefix, address, and other characters in the Command field.

The Repeat Command group box enables you to pass the specified string to a device occasionally. The
Attempt Count field will contain the total amount of strings that has been passed to a device. The Error field
displays a number of errors occurred while communicating with a device when the Start button is pressed.

3.5 Creating, Configuring and Deleting an OPC Tags

3.5.1 Creating a Tag Groups

A device can contain any number and level of groups, just like subdirectories. To add a group, select the
parent device or group, and choose New Group from the Add menu, right click on the parent and choose
New Group, or left click on the above button. A group only has a name, which must be unique among its
parent’s groups (just like subdirectories).

3.5.2 Creating a Tag

To add a tag, select the device or group on the left pane, and choose New Tag from the Add menu, right
click on the parent and choose New Tag, or left click on the above button. A tag has a name, which must be
unique within its group, a description, a location, and data type.

A data type can be 2 Bytes (Word), 4 Bytes (Dword), a 4 Byte or 8 Byte floating point number, or 1 Byte
(Bool).
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Tags can be scaled in the server, to convert to Engineering Units, for example. Selecting Enable Scaling on
the Tag Properties dialog box, and setting the scaling parameters accomplishes this. Scaled tags will be
converted to double precision floating point numbers when they are scaled.

For demos or checking the connectivity of clients to ADAM OPC Server , you can select Ramp, Random
or Sine simulation signals. There is also a simulation type that determines how the tag will be simulated
when the device is in that mode.

Datatype Sine Random Ramp

Boolean Toggles every 6 seconds Random on/off Toggles every 6 seconds

Short 0 to 100, period is 2 min Random from 0 to 100 Increments at scan rate

Long 0 to 100, period is 2 min Random from 0 to 100 Increments at scan rate

Double -1 to 1, period is 2 min Random from 0 to 100 Increments every 6 sec

The OPC item name, or ItemID, is made up of “device.group.tag” where the server uses periods as
delimiters. There are some clients that may use other delimiters between server name, access path, and
ItemID. This similar to the case of Excel’s DDE syntax “application|topic!item”. To avoid possible naming
conflicts in clients, the access path and itemID should be free of spaces and punctuation.

The Browse button enables you to configure a physical device parameters on-line or to bind a created tag to
the required device object model parameter. Once you clicks on the Browse button, the Device View dialog
box is displayed on the screen as shown in the figure below.

Fig. 3-7 Device View dialog box

To bind a created tag to the required device object model parameter, select this parameters on the left pane
of dialog box and clicks on OK.
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Fig. 3-8 Binding an OPC tag to the device object model parameter

3.5.3 Generating an OPC Tags Auto matically

The Fastwel ADAM OPC Server allows you to automatically create an OPC tags that will be linked to the
I/O channels of selected device type. Before you create an OPC tags automatically, you should create an
instance of device object model for the selected device type as described in "Creating Device" topic of this
manual.

To create an OPC tags automatically, select the device or group on the left pane, and choose Generate
Tags from the Add menu, or right click on the parent and choose Generate Tags. The tags list will be
displayed on the right pane as shown in the figure below.

Fig. 3-9 Generating an OPC tags automatically
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4. The ADAM-4000/5000 Series Object Model

4.1 Overview

The device object model for ADAM-4000 and ADAM-5000/485 devices is displayed on the left pane in the
Device View dialog box shown in figure below.

Fig. 4-1 Representation of device object model

Note that an instance of object based on device object model for selected device is actually created by
Fastwel ADAM OPC Server after double-clicking the topmost item in the list shown in figure above.

The Data Exchange group box on the up-right pane in the Device View dialog box allows you to interact
with a physical device including setting up device parameters and reading/writing values from/to a device.

Fig. 4-2 Data Exchange group box

The topmost field of the Data Exchange group box contains the name of selected parameter.

Once the Autoscan checkbox is checked, selecting an item on the left pane in the dialog box will cause an
appropriate command to be sent to the physical device automatically.

The combo box under the field with the name of selected parameter enables you to choose option for
selected parameter. To write selected option to the physical device, click on Write.

The bottom field on the Data Exchange group box contains the current value of selected parameter which
can be changed locally (without sending an appropriate command to the physical device) using the Change
button. Then you can write changed value to the physical device by clicking on Write. The result of
operation is displayed in the Operation result group box.
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4.2 The ADAM-4000 Object Model

4.2.1 ADAM-4011/D

AnalogInput

The analog input value. An OPC tag is read-only and can be generated automatically.

SynchronizedValue

The analog input value that was latched by device once the synchronized sampling command has been sent
(#**). The synchronized sampling command is sent by writing '1' to an OPC tag linked to the Synchronize
parameter that is described below. An OPC tag is read-only.

Synchronize

The broadcast command that requests devices to read their inputs and to latch obtained values. To send
this command from a client applications, you must write '1' to an OPC tag linked to the Synchronize
parameter.

HiAlarm

The flag which indicates that the analog input value is  greater than set by  HiAlarmLimit parameter. For
more information, see the ADAM-4000 Series User's Manual.

HiAlarmLimit

The high limit value that is set for an analog input. If the analog input value is greater than the
HiAlarmLimit, the HiAlarm is activated and the DO1/HI digital output is turned on. For more information,
see the ADAM-4000 Series User's Manual.

AlarmsMode

This option is used for choosing the local alarms mode of the ADAM-4011/D. There are three modes:

0 – No alarms use

1 – Momentary mode

2 – Latching mode

For more information, see the ADAM-4000 Series User's Manual.

LowAlarm

The flag which indicates that the analog input value is  less than set by  LoAlarmLimit parameter. For more
information, see the ADAM-4000 Series User's Manual.

LoAlarmLimit

The low limit value that is set for an analog input. If the analog input value is less than the LoAlarmLimit,
the LoAlarm is activated and the DO0/LO digital output is turned on. For more information, see the
ADAM-4000 Series User's Manual.

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4011/D. Please do not access
this parameter from an OPC clients. It is used for setting up the ADAM-4011 module manually. For more
information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4011is turned to INIT mode. An OPC clients should write decimal value to an
OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.
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IO_Range

A number which represents the analog input I/O range. This parameter accepts the following values:

0: �15 mV

1: �50 mV

2: �100 mV

3: �500 mV

4: �1 V

5: �2.5 V

6: �20 mA

14: Type J Thermocouple

15: Type K Thermocouple

16: Type T Thermocouple

17: Type E Thermocouple

18: Type R Thermocouple

19: Type S Thermocouple

20: Type B Thermocouple

An OPC clients may access this parameter when the ADAM-4011 is turned to INIT mode.

BaudRate

A number which represents the baud rate of the ADAM-4011 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4011 is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4011. This parameter accepts the following
values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4011 is turned to INIT mode.

IntegrationTime

A number which represents the cutoff frequency of internal digital filter of the ADAM-4011. This
parameter accepts the following values:

0: 60 Hz

1: 50 Hz

An OPC clients may access this parameter when the ADAM-4011 is turned to INIT mode.
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SpanCalibration

The command that requests a device to perform a span calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the SpanCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

ZeroCalibration

The command that requests a device to perform a zero calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the ZeroCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

CJC_Calibration

The command that requests a device to shift the scale of its internal CJC sensor. The minimum shift equals
approximately  0.009� C. For more information, see the ADAM-4000 Series User's Manual.

CJC_Sensor

The value which is measured by internal CJC sensor. An OPC tag is read-only. For more information, see
the ADAM-4000 Series User's Manual.

ThermocoupleOpen

The flag which indicates that a thermocouple is open. An OPC tag is read-only. This parameter is applied
to the ADAM-4011D only.

DigitalIn

The state of digital input. An OPC tag is read-only. For more information, see the ADAM-4000 Series
User's Manual.

DigitalOut0

The state of digital output DO0/LO. An OPC clients may write to an OPC item referenced to this
parameter when AlarmsMode parameter set to 0 (NoAlarms). For more information, see the ADAM-4000
Series User's Manual.

DigitalOut1

The state of digital output DO1/HI. An OPC clients may write to an OPC item referenced to this
parameter when AlarmsMode parameter set to 0 (NoAlarms). For more information, see the ADAM-4000
Series User's Manual.

4.2.2 ADAM-4012

AnalogInput

The analog input value. An OPC tag is read-only and can be generated automatically.

SynchronizedValue

The analog input value that was latched by device once the synchronized sampling command has been sent
(#**). The synchronized sampling command is sent by writing '1' to an OPC tag linked to the Synchronize
parameter that is described below. An OPC tag is read-only.

Synchronize

The broadcast command that requests devices to read their inputs and to latch obtained values. To send
this command from a client applications, you must write '1' to an OPC tag linked to the Synchronize
parameter.

HiAlarm

The flag which indicates that the analog input value is  greater than set by  HiAlarmLimit parameter. For
more information, see the ADAM-4000 Series User's Manual.

HiAlarmLimit

The high limit value that is set for an analog input. If the analog input value is greater than the
HiAlarmLimit, the HiAlarm is activated and the DO1/HI digital output is turned on. For more information,
see the ADAM-4000 Series User's Manual.
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AlarmsMode

This option is used for choosing the local alarms mode of the ADAM-4012. There are three modes:

0 – No alarms use

1 – Momentary mode

2 – Latching mode

For more information, see the ADAM-4000 Series User's Manual.

LowAlarm

The flag which indicates that the analog input value is  less than set by  LoAlarmLimit parameter. For more
information, see the ADAM-4000 Series User's Manual.

LoAlarmLimit

The low limit value that is set for an analog input. If the analog input value is less than the LoAlarmLimit,
the LoAlarm is activated and the DO0/LO digital output is turned on. For more information, see the
ADAM-4000 Series User's Manual.

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4012. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-4012 module manually. For more
information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4012 is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

IO_Range

A number which represents the analog input I/O range. This parameter accepts the following values:

8: �10 V

9: �5 V

10: �1 V

11: �500 mV

12: �150 mV

13: �20 mA

An OPC clients may access this parameter when the ADAM-4012 is turned to INIT mode.

BaudRate

A number which represents the baud rate of the ADAM-4012 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4012 is turned to INIT mode.
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CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4012. This parameter accepts the following
values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4012 is turned to INIT mode.

IntegrationTime

A number which represents the cutoff frequency of internal digital filter of the ADAM-4012.This
parameter accepts the following values:

0: 60 Hz

1: 50 Hz

An OPC clients may access this parameter when the ADAM-4012 is turned to INIT mode.

SpanCalibration

The command that requests a device to perform a span calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the SpanCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

ZeroCalibration

The command that requests a device to perform a zero calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the ZeroCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

DigitalIn

The state of digital input. An OPC tag is read-only. For more information, see the ADAM-4000 Series
User's Manual.

DigitalOut0

The state of digital output DO0/LO. An OPC clients may write to an OPC item referenced to this
parameter when AlarmsMode parameter set to 0 (NoAlarms). For more information, see the ADAM-4000
Series User's Manual.

DigitalOut1

The state of digital output DO1/HI. An OPC clients may write to an OPC item referenced to this
parameter when AlarmsMode parameter set to 0 (NoAlarms). For more information, see the ADAM-4000
Series User's Manual.

4.2.3 ADAM-4013

AnalogInput

The analog input value. An OPC tag is read-only and can be generated automatically.

SynchronizedValue

The analog input value that was latched by device once the synchronized sampling command has been sent
(#**). The synchronized sampling command is sent by writing '1' to an OPC tag linked to the Synchronize
parameter that is described below. An OPC tag is read-only.

Synchronize

The broadcast command that requests devices to read their inputs and to latch obtained values. To send
this command from a client applications, you must write '1' to an OPC tag linked to the Synchronize
parameter.

ConfigCode
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This DWORD parameter represents the configuration code of the ADAM-4013. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-4013 module manually. For more
information, see the ADAM-4000 Series User's Manual.
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NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4013 is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

IO_Range

A number which represents the analog input I/O range. This parameter accepts the following values:

32: Pt –100…+100� C � = 0.00385

33: Pt 0…+100� C � = 0.00385

34: Pt 0…+200� C � = 0.00385

35: Pt 0…+600� C � = 0.00385

36: Pt –100…+100� C � = 0.003916

37: Pt 0…+100� C � = 0.003916

38: Pt 0…+200� C � = 0.003916

39: Pt 0…+600� C � = 0.00385

40: Ni –80…+100� C

41: Ni 0…+100� C

An OPC clients may access this parameter when the ADAM-4013 is turned to INIT mode.

BaudRate

A number which represents the baud rate of the ADAM-4013 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4013 is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4013. This parameter accepts the following
values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4013 is turned to INIT mode.

IntegrationTime

A number which represents the cutoff frequency of internal digital filter of the ADAM-4013. This
parameter accepts the following values:

0: 60 Hz

1: 50 Hz

An OPC clients may access this parameter when the ADAM-4013 is turned to INIT mode.

SpanCalibration
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The command that requests a device to perform a span calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the SpanCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

ZeroCalibration

The command that requests a device to perform a zero calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the ZeroCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

4.2.4 ADAM-4014D

AnalogInput

The analog input value. An OPC tag is read-only and can be generated automatically.

SynchronizedValue

The analog input value that was latched by device once the synchronized sampling command has been sent
(#**). The synchronized sampling command is sent by writing '1' to an OPC tag linked to the Synchronize
parameter that is described below. An OPC tag is read-only.

Synchronize

The broadcast command that requests devices to read their inputs and to latch obtained values. To send
this command from a client applications, you must write '1' to an OPC tag linked to the Synchronize
parameter.

HiAlarm

The flag which indicates that the analog input value is  greater than set by  HiAlarmLimit parameter. For
more information, see the ADAM-4000 Series User's Manual.

HiAlarmLimit

The high limit value that is set for an analog input. If the analog input value is greater than the
HiAlarmLimit, the HiAlarm is activated and the DO1/HI digital output is turned on. For more information,
see the ADAM-4000 Series User's Manual.

AlarmsMode

This option is used for choosing the local alarms mode of the ADAM-4014D. There are three modes:

0 – No alarms use

1 – Momentary mode

2 – Latching mode

For more information, see the ADAM-4000 Series User's Manual.

LowAlarm

The flag which indicates that the analog input value is  less than set by  LoAlarmLimit parameter. For more
information, see the ADAM-4000 Series User's Manual.

LoAlarmLimit

The low limit value that is set for an analog input. If the analog input value is less than the LoAlarmLimit,
the LoAlarm is activated and the DO0/LO digital output is turned on. For more information, see the
ADAM-4000 Series User's Manual.

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4014D. Please do not access
this parameter from an OPC clients. It is used for setting up the ADAM-4014D module manually. For
more information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4014D is turned to INIT mode. An OPC clients should write decimal value to
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an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.



Fastwel ADAM OPC Server User's Guide

30

IO_Range

A number which represents the analog input I/O range. This parameter accepts the following values:

8: �10 V

9: �5 V

10: �1 V

11: �500 mV

12: �150 mV

13: �20 mA

An OPC clients may access this parameter when the ADAM-4014D is turned to INIT mode.

BaudRate

A number which represents the baud rate of the ADAM-4014D in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4014D is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4014D. This parameter accepts the
following values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4014D is turned to INIT mode.

IntegrationTime

A number which represents the cutoff frequency of internal digital filter of the ADAM-4014D. This
parameter accepts the following values:

0: 60 Hz

1: 50 Hz

An OPC clients may access this parameter when the ADAM-4014D is turned to INIT mode.

SpanCalibration

The command that requests a device to perform a span calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the SpanCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

ZeroCalibration

The command that requests a device to perform a zero calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the ZeroCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

DigitalIn

The state of digital input. An OPC tag is read-only. For more information, see the ADAM-4000 Series
User's Manual.
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DigitalOut0

The state of digital output DO0/LO. An OPC clients may write to an OPC item referenced to this
parameter when AlarmsMode parameter set to 0 (NoAlarms). For more information, see the ADAM-4000
Series User's Manual.

DigitalOut1

The state of digital output DO1/HI. An OPC clients may write to an OPC item referenced to this
parameter when AlarmsMode parameter set to 0 (NoAlarms). For more information, see the ADAM-4000
Series User's Manual.

EnableLEDMap

Reserved. This parameter can be used while you configure the ADAM-4014D from the server manually.
For more information, see the ADAM-4000 Series User's Manual.

TargetLEDMap

Reserved. This parameter can be used while you configure the ADAM-4014D from the server manually.
For more information, see the ADAM-4000 Series User's Manual.

SourceLoLimit

Reserved. This parameter can be used while you configure the ADAM-4014D from the server manually.
For more information, see the ADAM-4000 Series User's Manual.

SourceHiLimit

Reserved. This parameter can be used while you configure the ADAM-4014D from the server manually.
For more information, see the ADAM-4000 Series User's Manual.

LEDtLoLimit

Reserved. This parameter can be used while you configure the ADAM-4014D from the server manually.
For more information, see the ADAM-4000 Series User's Manual.

LEDHiLimit

Reserved. This parameter can be used while you configure the ADAM-4014D from the server manually.
For more information, see the ADAM-4000 Series User's Manual.

LEDSource

The flag that is used for choosing a source of data which will be displayed on the LED display. To choose a
PC as the source of data, write '2' to an OPC item referenced to this parameter. To choose an analog input
value to be displayed on the LED display, write '1' to an OPC item referenced to this parameter.

LEDData

The value which will be displayed on the LED display. An OPC tag is write-only. You may write to an
OPC item referenced to this parameter once you have written '2' to LEDSource.

4.2.5 ADAM-4016

AnalogInput

The analog input value. An OPC tag is read-only and can be generated automatically.

SynchronizedValue

The analog input value that was latched by device once the synchronized sampling command has been sent
(#**). The synchronized sampling command is sent by writing '1' to an OPC tag linked to the Synchronize
parameter that is described below. An OPC tag is read-only.

Synchronize

The broadcast command that requests devices to read their inputs and to latch obtained values. To send
this command from a client applications, you must write '1' to an OPC tag linked to the Synchronize
parameter.

HiAlarm
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The flag which indicates that the analog input value is  greater than set by  HiAlarmLimit parameter. For
more information, see the ADAM-4000 Series User's Manual.
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HiAlarmLimit

The high limit value that is set for an analog input. If the analog input value is greater than the
HiAlarmLimit, the HiAlarm is activated and the DO1/HI digital output is turned on. For more information,
see the ADAM-4000 Series User's Manual.

AlarmsMode

This option is used for choosing the local alarms mode of the ADAM-4016. There are three modes:

0 – No alarms use

1 – Momentary mode

2 – Latching mode

For more information, see the ADAM-4000 Series User's Manual.

LowAlarm

The flag which indicates that the analog input value is  less than set by  LoAlarmLimit parameter. For more
information, see the ADAM-4000 Series User's Manual.

LoAlarmLimit

The low limit value that is set for an analog input. If the analog input value is less than the LoAlarmLimit,
the LoAlarm is activated and the DO0/LO digital output is turned on. For more information, see the
ADAM-4000 Series User's Manual.

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4016. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-4016 module manually. For more
information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4016 is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

IO_Range

A number which represents the analog input I/O range. This parameter accepts the following values:

0: �15 V

1: �50 V

2: �100 V

3: �500 V

6: �20 mA

An OPC clients may access this parameter when the ADAM-4016 is turned to INIT mode.

BaudRate

A number which represents the baud rate of the ADAM-4016 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4016 is turned to INIT mode.
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CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4016.

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4016 is turned to INIT mode.

IntegrationTime

A number which represents the cutoff frequency of internal digital filter of the ADAM-4016. This
parameter accepts the following values:

0: 60 Hz

1: 50 Hz

An OPC clients may access this parameter when the ADAM-4016 is turned to INIT mode.

SpanCalibration

The command that requests a device to perform a span calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the SpanCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

ZeroCalibration

The command that requests a device to perform a zero calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the ZeroCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

ExcitationVoltage

An excitation voltage value for the strain gauge used. For more information, see the ADAM-4000 Series
User's Manual.

ExVoltageStartup

The command that requests the module to store its current excitation voltage value in the non-volatile
memory. An OPC tag is write-only.

TrimCalibration

A number of steps to that the excitation voltage must be shifted. One step equals approximately 1 mV. A
number of steps is represented by an integer within the range from –128 to 127.

DigitalOut0

The state of digital output DO0/LO. An OPC clients may write to an OPC item referenced to this
parameter when AlarmsMode parameter set to 0 (NoAlarms). For more information, see the ADAM-4000
Series User's Manual.

DigitalOut1

The state of digital output DO1/HI. An OPC clients may write to an OPC item referenced to this
parameter when AlarmsMode parameter set to 0 (NoAlarms). For more information, see the ADAM-4000
Series User's Manual.

DigitalOut2

The state of digital output DO2.

DigitalOut3

The state of digital output DO3.
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4.2.6 ADAM-4017

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4017. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-4017 module manually. For more
information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4017 is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

IO_Range

A number which represents the analog input I/O range. This parameter accepts the following values:

8: �10 V

9: �5 V

10: �1 V

11: �500 mV

12: �150 mV

13: �20 mA

An OPC clients may access this parameter when the ADAM-4017 is turned to INIT mode.

BaudRate

A number which represents the baud rate of the ADAM-4017 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4017 is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4017. This parameter accepts the following
values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4017 is turned to INIT mode.

IntegrationTime

A number which represents the cutoff frequency of internal digital filter of the ADAM-4017. This
parameter accepts the following values:

0: 60 Hz

1: 50 Hz

An OPC clients may access this parameter when the ADAM-4017 is turned to INIT mode.

ChannelMask
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The value that requests the ADAM-4017 to disable some of its analog inputs from reading. The mask
should be in decimal. For more information, see the ADAM-4000 Series User's Manual.

SpanCalibration

The command that requests a device to perform a span calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the SpanCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

ZeroCalibration

The command that requests a device to perform a zero calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the ZeroCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

InitForCalibration

The command that requests a device to disable its inputs excepting AI0. For more information, see the
ADAM-4000 Series User's Manual.

AnalogInput0...7

The analog input value. An OPC tags are read-only and can be generated automatically.

SynchronizedValue0...7

The analog input value that was latched by device once the synchronized sampling command has been sent
(#**). The synchronized sampling command is sent by writing '1' to an OPC tag linked to the Synchronize
parameter that is described below. An OPC tag is read-only.

Synchronize

The broadcast command that requests devices to read their inputs and to latch obtained values. To send
this command from a client applications, you must write '1' to an OPC tag linked to the Synchronize
parameter.

4.2.7 ADAM-4018

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4018. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-4018 module manually. For more
information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4018 is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

IO_Range

A number which represents the analog input I/O range. This parameter accepts the following values:

0: �15 mV

1: �50 mV

2: �100 mV

3: �500 mV

4: �1 V

5: �2,5 V

6: �20 mA

14: Type J Thermocouple

15: Type K Thermocouple

16: Type T Thermocouple
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17: Type E Thermocouple

18: Type R Thermocouple

19: Type S Thermocouple

20: Type B Thermocouple

An OPC clients may access this parameter when the ADAM-4018 is turned to INIT mode.

BaudRate

A number which represents the baud rate of the ADAM-4018 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

An OPC clients may access this parameter when the ADAM-4018 is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4018. This parameter accepts the following
values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4018 is turned to INIT mode.

IntegrationTime

A number which represents the cutoff frequency of internal digital filter of the ADAM-4018. This
parameter accepts the following values:

0: 60 Hz

1: 50 Hz

An OPC clients may access this parameter when the ADAM-4018 is turned to INIT mode.

ChannelMask

The value that requests the ADAM-4018 to disable some of its analog inputs from reading. The mask
should be in decimal. For more information, see the ADAM-4000 Series User's Manual.

SpanCalibration

The command that requests a device to perform a span calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the SpanCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

ZeroCalibration

The command that requests a device to perform a zero calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the ZeroCalibration parameter. For more
information, see the ADAM-4000 Series User's Manual.

InitForCalibration

The command that requests a device to disable its inputs excepting AI0. For more information, see the
ADAM-4000 Series User's Manual.

CJC_Calibration

The command that requests a device to shift the scale of its internal CJC sensor. The minimum shift equals
approximately  0,009� C. For more information, see the ADAM-4000 Series User's Manual.

CJC_Sensor
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The value which is measured by internal CJC sensor. An OPC tag is read-only. For more information, see
the ADAM-4000 Series User's Manual.

AnalogInput0...7

The analog input value. An OPC tag is read-only and can be generated automatically.

SynchronizedValue0...7

This command is not supported by ADAM-4018.

Synchronize

This command is not supported by ADAM-4018.

4.2.8 ADAM-4021

AnalogOutput0

The value which is sent out through the ADAM-4021 analog output. An OPC tag can be created
automatically.

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4021. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-4021 module manually. For more
information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4021 is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

IO_Range

The output range of the ADAM-4021 analog output. This parameter accepts the following values:

48: 0…20 mA

49: 4…20 mA

50: 0…10 V

An OPC clients may access this parameter when the ADAM-4021 is turned to INIT mode.

BaudRate

A number which represents the baud rate of the ADAM-4021 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4021 is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4021. This parameter accepts the following
values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4021 is turned to INIT mode.
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SlewRate

A rate with that a signal on the analog output will be changed once the code written to the ADAM-4021 is
differed by 1 LSB from the code that has been written before. An OPC tag is write-only in INIT mode.
This parameter accepts the following values:

0: Immediately

1: 0.0625 V/Sec (0.125 mA/Sec)

2: 0.125 V/Sec (0.250 mA/Sec)

3: 0.250 V/Sec (0.500 mA/Sec)

4: 0.5 V/Sec (1 mA/Sec)

5: 1 V/Sec (2 mA/Sec)

6: 2 V/Sec (4 mA/Sec)

7: 4 V/Sec (8 mA/Sec)

8: 8 V/Sec (16 mA/Sec)

9: 16 V/Sec (32 mA/Sec)

10: 32 V/Sec (64 mA/Sec)

11: 64 V/Sec (128 mA/Sec)

StartUpValue

The command that requests the module to store its output value in the non-volatile memory. An OPC tag
is write-only.

CurrentMeasured

Reserved

TrimCalibr

A number of steps to that the output value must be shifted. One step equals approximately 1 uA. A number
of steps is represented by an integer within the range from –95 to 95.

Calibr4mA

The command that requests the ADAM-4021 to perform 4 mA calibration. To send this command from a
client applications, you must write '1' to an OPC tag linked to the Calibr4mA parameter. For more
information, see the ADAM-4000 Series User's Manual.

Calibr20mA

The command that requests the ADAM-4021 to perform 20 mA calibration. To send this command from a
client applications, you must write '1' to an OPC tag linked to the Calibr20mA parameter. For more
information, see the ADAM-4000 Series User's Manual.

4.2.9 ADAM-4050

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4050. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-4050 module manually. For more
information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4050 is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

BaudRate
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A number which represents the baud rate of the ADAM-4050 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4050 is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4050. This parameter accepts the
following values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4050 is turned to INIT mode.

DataWordIn

The state of digital inputs and outputs. An OPC tag is read-only. An OPC clients get a state as DWORD
decimal value which must be converted to WORD hexadecimal. Then you must discard the most
significant byte. The given 24 bit value has the following format:

� the most significant byte represents digital outputs state;

� the middle byte represents digital inputs state;

� the least significant byte equals '0'.

The channels’ state follows from right to left. For more information, see the ADAM-4000 Series User's
Manual.

DataWordOut

The command which is used for changing the state of digital outputs simultaneously. For more
information, see the ADAM-4000 Series User's Manual.

SynchroDataWord

See DataWordIn. The channels status that was latched by device after synchronized sampling command
has been sent (#**). The synchronized sampling command is sent by writing '1' to an OPC tag linked to the
Synchronize parameter that is described below. An OPC tag is read-only.

Synchronize

The broadcast command that requests devices to read their inputs and to latch obtained values. To send
this command from a client applications, you must write '1' to an OPC tag linked to the Synchronize
parameter.

ResetStatus

The flag which indicates either the module was reset by internal watchdog timer. For more information,
see the ADAM-4000 Series User's Manual.

BitIn0...6

The logical state of DI0...6 digital inputs. An OPC tags can be created automatically.

BitSynchro0...6

The logical state of DI0...6 digital inputs that was latched by ADAM-4050 when the broadcast command
#** has been received.

BitOut0...7
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The logical state of DO0...6 digital outputs. An OPC tags can be created automatically.

4.2.10 ADAM-4052

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4052. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-4052 module manually. For more
information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4052 is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

BaudRate

A number which represents the baud rate of the ADAM-4052 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4052 is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4052. This parameter accepts the
following values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4052 is turned to INIT mode.

DataWordIn

The state of digital inputs and outputs. An OPC tag is read-only. An OPC clients get a state as DWORD
decimal value which must be converted to WORD hexadecimal. Then you must discard the most
significant byte. The given 24 bit value has the following format:

� the most significant byte represents digital inputs state;

� the middle byte equals '0';

� the least significant byte equals '0'.

The channels state follows from right to left. For more information, see the ADAM-4000 Series User's
Manual.

DataWordOut

Not Supported

SynchroDataWord

See DataWordIn. The channels state that was latched by device after synchronized sampling command has
been sent (#**). The synchronized sampling command is sent by writing '1' to an OPC tag linked to the
Synchronize parameter that is described below. An OPC tag is read-only.

Synchronize
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The broadcast command that requests devices to read their inputs and to latch obtained values. To send
this command from a client applications, you must write '1' to an OPC tag linked to the Synchronize
parameter.

ResetStatus

The flag which indicates either the module was reset by internal watchdog timer. For more information,
see the ADAM-4000 Series User's Manual.

BitIn0...7

The logical state of DI0...7 digital inputs. An OPC tags can be created automatically.

BitSynchro0...7

The logical state of DI0...6 digital inputs that was latched by ADAM-4052 when the broadcast command
#** has been received.
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4.2.11 ADAM-4053

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4053. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-4053 module manually. For more
information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4053 is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

BaudRate

A number which represents the baud rate of the ADAM-4053 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4053 is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4053. This parameter accepts the
following values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4053 is turned to INIT mode.

DataWordIn

The state of digital inputs. An OPC tag is read-only. An OPC clients get a state as DWORD decimal value
which must be converted to WORD hexadecimal. Then you must discard the most significant byte. The
given 24 bit value has the following format:

� the most significant and the middle bytes represent digital inputs state;

� the least significant byte equals '0'.

The channels state follows from right to left. For more information, see the ADAM-4000 Series User's
Manual.

DataWordOut

Not Supported

SynchroDataWord

See DataWordIn. The channels state that was latched by device after synchronized sampling command has
been sent (#**). The synchronized sampling command is sent by writing '1' to an OPC tag linked to the
Synchronize parameter that is described below. An OPC tag is read-only.

Synchronize

The broadcast command that requests devices to read their inputs and to latch obtained values. To send
this command from a client applications, you must write '1' to an OPC tag linked to the Synchronize
parameter.
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ResetStatus

The flag which indicates either the module was reset by internal watchdog timer. For more information,
see the ADAM-4000 Series User's Manual.

BitIn0...15

The logical state of DI0...15 digital inputs. An OPC tags can be created automatically.

BitSynchro0...15

The logical state of DI0...15 digital inputs that was latched by ADAM-4053 when the broadcast command
#** has been issued.

4.2.12 ADAM-4060

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4060. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-4060 module manually. For more
information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4060 is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

BaudRate

A number which represents the baud rate of the ADAM-4060 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4060 is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4060. This parameter accepts the
following values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4060 is turned to INIT mode.

DataWordIn

The state of digital inputs and outputs. An OPC tag is read-only. An OPC clients get a state as DWORD
decimal value which must be converted to WORD hexadecimal. Then you must discard the most
significant byte. The given 24 bit value has the following format:

� the most significant byte represents digital outputs state;

� the middle byte equals '0';

� the least significant byte equals '0'.

The channels state follows from right to left. For more information, see the ADAM-4000 Series User's
Manual.

DataWordOut
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The command which is used for changing the state of digital outputs simultaneously. For more
information, see the ADAM-4000 Series User's Manual.



Fastwel ADAM OPC Server User's Guide

46

SynchroDataWord

See DataWordIn. The channels state that was latched by device after synchronized sampling command has
been sent (#**). The synchronized sampling command is sent by writing '1' to an OPC tag linked to the
Synchronize parameter that is described below. An OPC tag is read-only.

ResetStatus

The flag which indicates either the module was reset by internal watchdog timer. For more information,
see the ADAM-4000 Series User's Manual.

BitOut0...3

The logical state of RL0...3 digital inputs. An OPC tags can be created automatically.

4.2.13 ADAM-4080

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4080. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-4080 module manually. For more
information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4080 is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

BaudRate

A number which represents the baud rate of the ADAM-4080 in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4080 is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4080. This parameter accepts the
following values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4080 is turned to INIT mode.

SlewRate

The flag that is used for choosing the period of frequency measurement. An OPC clients may write to this
parameter when the ADAM-4080 is turned to INIT mode. There are two options for this parameter:

0: 0.1 Sec

1: 1.0 Sec

IsolatedMode

The flag that indicates either Isolated or Non-Isolated mode is chosen. This parameter accepts the
following values:

0: Non-Isolated (TTL) Mode
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1: Isolated Mode

GateMode

Requests the counter/frequency measurement module to set its gate mode to either high, low or disabled.
This parameter accepts the following values:

0: the gate is low

1: the gate is high

2: the gate is disabled

EnableFilter

Requests the counter/frequency measurement module to enable/disable its built-in digital filter. This
parameter accepts the following values:

0: the filter is disabled

1: the filter is enabled

MinWidthAtHiLevel

Sets the minimum input signal width setting at high level for the counter/frequency measurement module.
The signal width is represented in units of duration where the one unit equals approximately 1 uS. The
value that is passed to an OPC tag referenced to this parameter must be within the range from 2 to 65535.

MinWidthAtLoLevel

Sets the minimum input signal width setting at low level for the counter/frequency measurement module.
The signal width is represented in units of duration where the one unit equals approximately 1 uS. The
value that is passed to an OPC tag referenced to this parameter must be within the range from 2 to 65535.

TriggerLevelHi

Sets the high trigger level of non-isolated input signals. The value that is passed to an OPC tag referenced
to this parameter must be within the range from 1 to 50 (from 0.1 to 5.0 V).

TriggerLevelLo

Sets the low trigger level of non-isolated input signals. The value that is passed to an OPC tag referenced to
this parameter must be within the range from 1 to 50 (from 0.1 to 5.0 V).

OutAndAlarmStatus

Asks the state of the ADAM-4080 digital input channel, its two digital output channels and the state of its
alarm. An OPC tag is read-only. For more information, refer to the ADAM-4000 Series User's Manual.

Counter0

The count value of Counter 0. An OPC tag is read-only and can be created automatically.

MaxCount0

The maximum value for Counter 0.

StartStop0

The command which requests the Counter 0 to start/stop its counting or status of Counter 0. This
parameter accepts the following values:

0: Stop Counting

1: Start Counting

Overflow0

The overflow flag of Counter 0.

Possible values when reading:

0: No overflow

1: Overflow

Possible values when writing
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0: Reset the overflow state
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InitCountValue0

Sets the initial value for Counter 0.

EnableAlarm0

The command which enables alarms for Counter 0. An OPC tag is write-only.

DisableAlarm0

The command which disables alarms for Counter 0. An OPC tag is write-only.

AlarmLimit0

Sets the alarm value for Counter 0.

Counter1

The count value of Counter 1. An OPC tag is read-only and can be created automatically.

MaxCount1

The maximum value for Counter 1.

StartStop1

The command which requests the Counter 1 to start/stop its counting or state of Counter 1. This parameter
accepts the following values:

0: Stop Counting

1: Start Counting

Overflow1

The overflow flag of Counter 1.

Possible values when reading:

0: No overflow

1: Overflow

Possible values when writing:

0: Reset the overflow state

InitCountValue1

Sets the initial value for Counter 1.

EnableAlarm1

The command which enables alarms for Counter 1. An OPC tag is write-only.

DisableAlarm1

The command which disables alarms for Counter 1. An OPC tag is write-only.

AlarmLimit1

Sets the alarm value for Counter 1.

DigitalOut0

The status of digital output DO0/LO. An OPC clients may write to an OPC item referenced to this
parameter if at least one time the DisableAlarm command has been issued. For more information, see the
ADAM-4000 Series User's Manual.

DigitalOut1

The status of digital output DO1/HI. An OPC clients may write to an OPC item referenced to this
parameter if at least one time the DisableAlarm command has been issued. For more information, see the
ADAM-4000 Series User's Manual.
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4.2.14 ADAM-4080D

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-4080D. Please do not access
this parameter from an OPC clients. It is used for setting up the ADAM-4080D module manually. For
more information, see the ADAM-4000 Series User's Manual.

NewAddress

A number which represents a new address for the module in the network. An OPC clients may access this
parameter when the ADAM-4080D is turned to INIT mode. An OPC clients should write decimal value to
an OPC item referenced to the NewAddress parameter. For more information, see the ADAM-4000 Series
User's Manual.

BaudRate

A number which represents the baud rate of the ADAM-4080D in the network. This parameter accepts the
following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

An OPC clients may access this parameter when the ADAM-4080D is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-4080D. This parameter accepts the
following values:

0 – Checksum is not used

1 – Checksum is used

An OPC clients may access this parameter when the ADAM-4080D is turned to INIT mode.

SlewRate

The flag that is used for choosing the period of frequency measurement. . An OPC clients may write to this
parameter when the ADAM-4080D is turned to INIT mode. There are two options for this parameter:

0: 0.1 Sec

1: 1.0 Sec

IsolatedMode

The flag that indicates either Isolated or Non-Isolated mode is chosen. This parameter accepts the
following values:

0: Non-Isolated (TTL) Mode

1: Isolated Mode

LEDDataOrigin

The flag that is used for choosing a source of data which will be displayed on the LED display. To choose a
PC as the data source, write '2' to an OPC item referenced to this parameter. To choose the Counter 0
value to be displayed on the LED display, write '0' to an OPC item referenced to this parameter. To choose
the Counter 1 value to be displayed on the LED display, write '1' to an OPC item referenced to this
parameter.

LEDData
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The value which will be displayed on the LED display. An OPC tag is write-only. You may write to an
OPC item referenced to this parameter once you have written '2' to LEDDataOrigin.
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GateMode

Requests the counter/frequency measurement module to set its gate mode to either high, low or disabled.
This parameter accepts the following values:

0: the gate is low

1: the gate is high

2: the gate is disabled

EnableFilter

Requests the counter/frequency measurement module to enable/disable its built-in digital filter. This
parameter accepts the following values:

0: the filter is disabled

1: the filter is enabled

MinWidthAtHiLevel

Sets the minimum input signal width setting at high level for the counter/frequency measurement module.
The signal width is represented in units of duration where the one unit equals approximately 1 uS. The
value that is passed to an OPC tag referenced to this parameter must be within the range from 2 to 65535.

MinWidthAtLoLevel

Sets the minimum input signal width setting at low level for the counter/frequency measurement module.
The signal width is represented in units of duration where the one unit equals approximately 1 uS. The
value that is passed to an OPC tag referenced to this parameter must be within the range from 2 to 65535.

TriggerLevelHi

Sets the high trigger level of non-isolated input signals. The value that is passed to an OPC tag referenced
to this parameter must be within the range from 1 to 50 (from 0.1 to 5.0 V).

TriggerLevelLo

Sets the low trigger level of non-isolated input signals. The value that is passed to an OPC tag referenced to
this parameter must be within the range from 1 to 50 (from 0.1 to 5.0 V).

OutAndAlarmStatus

Asks the state of the ADAM-4080D digital input channel, its two digital output channels and the status of
its alarm. An OPC tag is read-only. For more information, refer to the ADAM-4000 Series User's Manual.

Counter0

The count value of Counter 0. An OPC tag is read-only and can be created automatically.

MaxCount0

The maximum value for Counter 0.

StartStop0

The command which requests the Counter 0 to start/stop its counting or status of Counter 0. This
parameter accepts the following values:

0: Stop Counting

1: Start Counting

Overflow0

The overflow flag of Counter0.

Possible values when reading:

0: No overflow

1: Overflow

Possible values when writing
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0: Reset the overflow status
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InitCountValue0

Sets the initial value for Counter 0.

AlarmMode

This option is used for choosing the local alarms mode of the ADAM-4014D. There are three modes:

0 – No alarms use

1 – Momentary mode

2 – Latching mode

For more information, see the ADAM-4000 Series User's Manual.

ClearLatchAlarm

Sets both alarm states to OFF. For more information, refer to the ADAM-4000 Series User's Manual.

AlarmLimit0

Sets the alarm value for Counter 0.

Counter1

The count value of Counter 1. An OPC tag is read-only and can be created automatically.

MaxCount1

The maximum value for Counter 1.

StartStop1

The command which requests the Counter 1 to start/stop its counting or status of Counter 1. This
parameter accepts the following values:

0: Stop Counting

1: Start Counting

Overflow1

The overflow flag of Counter 1.

Possible values when reading:

0: No overflow

1: Overflow

Possible values when writing:

0: Reset the overflow status

InitCountValue1

Sets the initial value for Counter 1.

The command which disables alarms for Counter 1. An OPC tag is write-only.

AlarmLimit1

Sets the alarm value for Counter 1.

DigitalOut0

The status of digital output DO0/LO. An OPC clients may write to an OPC item referenced to this
parameter when AlarmMode parameter set to 0 (NoAlarms). For more information, see the ADAM-4000
Series User's Manual.

DigitalOut1

The status of digital output DO1/HI. An OPC clients may write to an OPC item referenced to this
parameter when AlarmMode parameter set to 0 (NoAlarms).. For more information, see the ADAM-4000
Series User's Manual.
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4.3 The ADAM-5000/485 Object Model

4.3.1 ADAM-5000/485 CPU Base

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-5000/485 CPU base. Please do
not access this parameter from an OPC clients. It is used for setting up the ADAM-5000 CPU manually.
For more information, see the ADAM-5000/485 Series User's Manual.

BaudRate

A number which represents the baud rate of the ADAM-5000/485 in the network. This parameter accepts
the following values:

3: 1200 bps

4: 2400 bps

5: 4800 bps

6: 9600 bps

7: 19200 bps

8: 38400 bps

9: 57600 bps

10: 115200 bps

An OPC clients may access this parameter when the ADAM-5000/485 is turned to INIT mode.

CheckSumStatus

The flag which indicates either the checksum is used by ADAM-5000/485. This parameter accepts the
following values:

0 – Checksum is not used

1 – Checksum is used

ResetStatus

The flag which indicates either the ADAM-5000/485 was reset by internal watchdog timer. For more
information, see the ADAM-5000/485 Series User's Manual.

DiagnosticCode

Requests the ADAM-5000/485 CPU to return the error status. An OPC tag is read-only. For more
information, see the ADAM-5000/485 Series User's Manual.

4.3.2 ADAM-5017

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-5017. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-5017 module manually. For more
information, see the ADAM-5000/485 Series User's Manual.

IO_Range

A number which represents the analog input I/O range. This parameter accepts the following values:

8: �10 V

9: �5 V

10: �1 V

11: �500 mV
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12: �150 mV

13: �20 mA
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IntegrationTime

A number which represents the cutoff frequency of internal digital filter of the ADAM-5017. This
parameter accepts the following values:

0: 60 Hz

1: 50 Hz

ChannelMask

The value that requests the ADAM-5017 to disable some of its analog inputs from reading. The mask
should be in decimal. For more information, see the ADAM-5000/485 Series User’s Manual.

SpanCalibration

The command that requests a device to perform a span calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the SpanCalibration parameter. For more
information, see the ADAM-5000/485 Series User’s Manual.

ZeroCalibration

The command that requests a device to perform a zero calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the ZeroCalibration parameter. For more
information, see the ADAM-5000/485 Series User’s Manual.

InitForCalibration

The command that requests a device to disable its inputs excepting AI0. For more information, see the
ADAM-5000/485 Series User’s Manual.

AnalogInput0...7

The analog input value. An OPC tag is read-only and can be generated automatically.

HiAlarm

The flag which indicates that the analog input value is greater than set by  HiAlarmLimit parameter for the
specified analog input. For more information, see the ADAM-5000/485 Series User's Manual.

HiAlarmLimit

The high limit value that is set for the specified analog input. If the analog input value is greater than the
HiAlarmLimit, the HiAlarm is activated and the digital output that was set up by HiAlarmConnection
parameter is turned on. For more information, see the ADAM-5000/485 Series User's Manual.

HiAlarmMode

This option is used for choosing the local alarms mode for the HiAlarm. There are three modes:

0 – No alarms use

1 – Momentary mode

2 – Latching mode

For more information, see the ADAM-5000/485 Series User's Manual.

EnableHiAlarm

The command which enables high alarms. An OPC tag is write-only. This parameter accepts the following
values:

0 – disables high alarms

1 – enables high alarms

HiAlarmConnection

The designator of digital output which performs the local digital control at high alarm condition. For more
information, see the ADAM-5000/485 Series User's Manual.

LoAlarm
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The flag which indicates that the analog input value is less than set by  LoAlarmLimit parameter for the
specified analog input. For more information, see the ADAM-5000/485 Series User's Manual.
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LoAlarmLimit

The low limit value that is set for the specified analog input. If the analog input value is less than the
LoAlarmLimit, the LoAlarm is activated and the digital output that was set up by LoAlarmConnection
parameter is turned on. For more information, see the ADAM-5000/485 Series User's Manual.

LoAlarmMode

This option is used for choosing the local alarms mode for the LoAlarm. There are three modes:

0 – No alarms use

1 – Momentary mode

2 – Latching mode

For more information, see the ADAM-5000/485 Series User's Manual.

EnableLoAlarm

The command which enables low alarms. An OPC tag is write-only. This parameter accepts the following
values:

0 – disables high alarms

1 – enables high alarms

LoAlarmConnection

The designator of digital output which performs the local digital control at low alarm condition. For more
information, see the ADAM-5000/485 Series User's Manual.

4.3.3 ADAM-5018

ConfigCode

This DWORD parameter represents the configuration code of the ADAM-5018. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-5018 module manually. For more
information, see the ADAM-5000/485 Series User's Manual.

IO_Range

A number which represents the analog input I/O range. This parameter accepts the following values:

0: �15 mV

1: �50 mV

2: �100 mV

3: �500 mV

4: �1 V

5: �2.5 V

6: �20 mA

14: Type J Thermocouple

15: Type K Thermocouple

16: Type T Thermocouple

17: Type E Thermocouple

18: Type R Thermocouple

19: Type S Thermocouple

20: Type B Thermocouple
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IntegrationTime

A number which represents the cutoff frequency of internal digital filter of the ADAM-5018. This
parameter accepts the following values:

0: 60 Hz

1: 50 Hz

ChannelMask

The value that requests the ADAM-5018 to disable some of its analog inputs from reading. The mask
should be in decimal. For more information, see the ADAM-5000/485 Series User’s Manual.

SpanCalibration

The command that requests a device to perform a span calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the SpanCalibration parameter. For more
information, see the ADAM-5000/485 Series User’s Manual.

ZeroCalibration

The command that requests a device to perform a zero calibration. To send this command from a client
applications, you must write '1' to an OPC tag linked to the ZeroCalibration parameter. For more
information, see the ADAM-5000/485 Series User’s Manual.

InitForCalibration

The command that requests a device to disable its inputs excepting AI0. For more information, see the
ADAM-5000/485 Series User’s Manual.

CJC_Calibration

The command that requests a device to shift the scale of its internal CJC sensor. The minimum shift equals
approximately  0.009� C. For more information, see the ADAM-5000/485 Series User's Manual.

CJC_Sensor

The value which is measured by internal CJC sensor. An OPC tag is read-only. For more information, see
the ADAM-5000/485 Series User's Manual.

AnalogInput0...7

The analog input value. An OPC tag is read-only and can be generated automatically.

HiAlarm

The flag which indicates that the analog input value is greater than set by  HiAlarmLimit parameter for the
specified analog input. For more information, see the ADAM-5000/485 Series User's Manual.

HiAlarmLimit

The high limit value that is set for the specified analog input. If the analog input value is greater than the
HiAlarmLimit, the HiAlarm is activated and the digital output that was set up by HiAlarmConnection
parameter is turned on. For more information, see the ADAM-5000/485 Series User's Manual.

HiAlarmMode

This option is used for choosing the local alarms mode for the HiAlarm. There are three modes:

0 – No alarms use

1 – Momentary mode

2 – Latching mode

For more information, see the ADAM-5000/485 Series User's Manual.

EnableHiAlarm

The command which enables high alarms. An OPC tag is write-only. This parameter accepts the following
values:

0 – disables high alarms
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1 – enables high alarms
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HiAlarmConnection

A digital output which performs the local digital control at high alarm condition. For more information,
see the ADAM-5000/485 Series User's Manual.

LoAlarm

The flag which indicates that the analog input value is less than set by  LoAlarmLimit parameter for the
specified analog input. For more information, see the ADAM-5000/485 Series User's Manual.

LoAlarmLimit

The low limit value that is set for the specified analog input. If the analog input value is less than the
LoAlarmLimit, the LoAlarm is activated and the digital output that was set up by LoAlarmConnection
parameter is turned on. For more information, see the ADAM-5000/485 Series User's Manual.

LoAlarmMode

This option is used for choosing the local alarms mode for the LoAlarm. There are three modes:

0 – No alarms use

1 – Momentary mode

2 – Latching mode

For more information, see the ADAM-5000/485 Series User's Manual.

EnableLoAlarm

The command which enables low alarms. An OPC tag is write-only. This parameter accepts the following
values:

0 – disables high alarms

1 – enables high alarms

LoAlarmConnection

The designator of digital output which performs the local digital control at low alarm condition. For more
information, see the ADAM-5000/485 Series User's Manual.

4.3.4 ADAM-5024

AnalogOutput0…3

The value which is sent out through the ADAM-5024 analog outputs. An OPC tag can be created
automatically.

ConfigurationCode

This DWORD parameter represents the configuration code of the ADAM-5024. Please do not access this
parameter from an OPC clients. It is used for setting up the ADAM-5024 module manually. For more
information, see the ADAM-5000/485 Series User's Manual.

IO_Range

The output range of the ADAM-5024 analog outputs. This parameter accepts the following values:

48: 0…20 mA

49: 4…20 mA

50: 0…10 V

SlewRate

A rate with that a signal on the analog outputs will be changed once the code written to the ADAM-5024 is
differed by 1 LSB from the code that has been written before. An OPC tag is write-only in INIT mode.
This parameter accepts the following values:

0: Immediately

1: 0.0625 V/Sec (0.125 mA/Sec)
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2: 0.125 V/Sec (0.250 mA/Sec)

3: 0.250 V/Sec (0.500 mA/Sec)

4: 0.5 V/Sec (1 mA/Sec)

5: 1 V/Sec (2 mA/Sec)

6: 2 V/Sec (4 mA/Sec)

7: 4 V/Sec (8 mA/Sec)

8: 8 V/Sec (16 mA/Sec)

9: 16 V/Sec (32 mA/Sec)

10: 32 V/Sec (64 mA/Sec)

11: 64 V/Sec (128 mA/Sec)

StartUpValue

The command that requests the module to store its outputs values in the non-volatile memory. An OPC tag
is write-only.

TrimCalibr

A number of steps to that the output value must be shifted. One step equals approximately 1 uA. A number
of steps is represented by an integer within the range from –95 to 95.

Calibr4mA

The command that requests the ADAM-5024 to perform 4 mA calibration. To send this command from a
client applications, you must write '1' to an OPC tag linked to the Calibr4mA parameter. For more
information, see the ADAM-5000/485 Series User's Manual.

Calibr20mA

The command that requests the ADAM-5024 to perform 20 mA calibration. To send this command from a
client applications, you must write '1' to an OPC tag linked to the Calibr20mA parameter. For more
information, see the ADAM-5000/485 Series User's Manual.

4.3.5 ADAM-5051

DataWord

The state of digital inputs. An OPC tag is read-only. An OPC clients get a state as DWORD decimal value
which must be converted to WORD hexadecimal. Then you must discard the most significant byte. The
given 24 bit value has the following format:

� the most significant and the middle bytes represent digital inputs status

� the least significant byte equals '0'.

The channels states follow from right to left. For more information, see the ADAM-5000/485 Series User's
Manual.

BitIn0...15

The logical state of DI0...15 digital inputs. An OPC tags can be created automatically.

4.3.6 ADAM-5052

DataWord

The state of digital inputs. An OPC tag is read-only. An OPC clients get a state as DWORD decimal value
which must be converted to WORD hexadecimal. Then you must discard the most significant byte. The
given 24 bit value has the following format:

� the most significant byte represents digital inputs status

� the middle byte equals '0'

� the least significant byte equals '0'.
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The channels states follow from right to left. For more information, see the ADAM-5000/485 Series User's
Manual.
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BitIn0...7

The logical state of DI0...7 digital inputs. An OPC tags can be created automatically.

4.3.7 ADAM-5056

DataWord

The state of digital outputs. An OPC tag is read-only. An OPC clients get a state as DWORD decimal value
which must be converted to WORD hexadecimal. Then you must discard the most significant byte. The
given 24 bit value has the following format:

� the most significant byte equals '0'

� the middle and least significant byte represents digital outputs status

The channels states follow from right to left. For more information, see the ADAM-5000/485 Series User's
Manual.

Bit0...15

The logical state of DO0...15 digital outputs. An OPC tags can be created automatically.

4.3.8 ADAM-5060

DataWord

The state of relay outputs. An OPC tag is read-only. An OPC clients get a state as DWORD decimal value
which must be converted to WORD hexadecimal. Then you must discard the most significant byte. The
given 24 bit value has the following format:

� the most significant and the least bytes equal '0'

� the least significant byte represents relay outputs status

The channels status follows from right to left. For more information, see the ADAM-5000/485 Series
User's Manual.

Bit0...5

The state of RL0...5 relay outputs. An OPC tags can be created automatically.


